What have I gotten myself into?
Some basic questions and simple answers about Sony Movie Studio 13 and how it works

What is non-linear editing (NLE)?
Non-linear editing is basically another term for editing video on a computer. “Non-linear” is in contrast to linear editing – the way video and film used to be edited in the days of tape and film reels. In those days, if you wanted to take a scene from the beginning of a reel of film or tape and you wanted to cut it with another at the end, you’d need to go through the entire reel to grab each scene. That’s linear editing. In order to get from this piece to that piece, you have to go through everything in between.

In non-linear video, your scenes or clips appear in a catalog (the Project Media window) and you just grab and mix them in any order you want. A much easier way to work, don’t you think?

What’s the difference between Sony Movie Studio, Sony Movie Studio Platinum and Vegas Pro?
Well, in terms of the quality of the results, absolutely nothing. They all produce the same excellent quality of video outputs.

The Pro version, however, includes a number of higher-end features (such as support for XDCAMs and RED ONE camcorders).

Sony Movie Studio Platinum’s bundle includes DVD Architect Studio DVD/BluRay authoring software, a slideshow creator tool and advanced color correction tools that are not included with plain vanilla Sony Movie Studio. (Among the Studio line, the Movie Studio Platinum Suite is far and away the best value.)

Sony has a chart listing all of the major feature differences at: http://www.sonycreativesoftware.com/moviestudiope/compare
Can I mix more than one type of video in my Movie Studio project?
You certainly can – and the results are usually very good (particularly if you tweak your Project Properties, as we recommend on page 257). However, you’ll always get the best performance and the best results from the program when your project settings match your source video as closely as possible, as we discuss in Chapter 2, Start a New Project.

What is an Event?
Video and audio, while on your hard drive or in the Project Media window, are called media clips. Once they are added to your project’s timeline, they become events. Timeline events can be split and trimmed, or they can be set up to interact with other events on the timeline.

Video editing in Movie Studio, by the way, is a non-destructive process. That means that nothing you do to the events on your timeline will have any effect on your original video and audio clips. They will not be changed or damaged in any way.

What is an Envelope?
When you create an Envelope on your Movie Studio timeline, you create a workspace in which certain audio and video levels can be set to vary over time. You can use envelopes, for instance, to vary the volume level at specific points on an audio track or to lower the opacity level of a video track.

We’ll show you how to use envelopes to control audio levels on your timeline at specific points in Chapter 9, Edit Audio on the Timeline. And we’ll show you how to use envelopes to control video properties in Chapter 15, Vary Effects with Keyframes.

What is keyframed animation?
Like an envelope, a keyframed animation can be used to vary the levels or other characteristics of an effect or transition over time. A keyframed animation, for instance, can be used to create a pan and zoom motion path in a slideshow or to create an effect or title that changes in intensity or shape over time. Using keyframes, you can create an animation in which a clip starts out normal, then morphs into a swirl – then goes back to normal again.

Keyframing is one of the most powerful tools for creating effects and mixing audio in this program. Fortunately, Sony has designed the tools for making, creating and editing keyframes and animations very intuitive and easy to use.

We’ll show you how to unleash the power of keyframing and animation in Chapter 15, Vary Effects with Keyframes.

What is an Instance?
An Instance is, basically, an open Movie Studio project. By opening several instances of Sony Movie Studio at the same time, you can cut and paste events or even entire sequences from one project to another. We’ll show you how to do this in Chapter 7, More Timeline Tools.

What’s the difference between the Sony Movie Studio Explorer window and the Project Media window?
The Movie Studio Explorer window shows you all of the media that is on your computer’s hard drive. The Project Media window, on the other hand, lists only the video, audio clips or stills that you’ve actually added to your Movie Studio project.

We’ll show you how to add media to your Project Media window in Chapter 3, Get Media Into Your Project.

What is a Media Bin?
Media Bins are folders and sub-folders that you create in order to organize the media clips in your Project Media window.

Media Bins can be very helpful if your project includes dozens of media clips. You can, for instance, create one Media Bin folder for your titles, another for your audio, another for video clips shot at the Grand Canyon, etc. Media Bins make it easy for your to manage and locate the media in your project.

We’ll show you how to organize your clips with Media Bins in Chapter 4, Order and Prep Clips in the Project Media Window.

What is the Trimmer?
The Trimmer in Movie Studio 13 is hidden by default, but in Advanced mode it launches automatically whenever it’s needed. In the Trimmer, you can preview clips that are in the Explorer or Project Media window. You can also pre-trim your video or audio clips before adding them to your timeline (isolating a small segment of a longer clip, for instance) or save a pre-trimmed clip back to your Project Media window as a sub-clip.

We’ll show you how to use the tools in this window in Chapter 5, Prepare Your Media in the Trimmer.

What is the Loop Region?
A Loop Region is a segment you define on your timeline. Isolating segments of your timeline as Loop Regions, you can define which portion of your movie will be rendered and/or output. Using this feature, for instance, you can opt to output a video of only a portion of a longer movie.

We’ll show you how to set up and use a Loop Region in Chapter 6, Edit Video on the Timeline and Chapter 7, More Timeline Tools.

What are the Snapping and Quantize to Frame features?
The Snapping feature controls how your media clips align when you place them on your timeline. When Snapping is enabled, any clips you add to or trim on your timeline will automatically “snap” to align themselves with the playhead, grid other clips or the Timeline.
The Quantize to Frames feature ensures that any trims that you make to the video or audio on your timeline are no smaller than a video frame. As with Snapping, it’s probably best to leave this feature toggled on except for special situations.

The Snapping and Quantize to Frames options are turned on or off either on the Toolbar that appears at the top of the program’s interface or under the Options menu.

What is Pre-Rendering and why should I do it?
Pre-rendering means creating a fully-rendered preview of an event clip to which effects have been added. The program will then use the pre-rendered segment in place of the effects-laden segment.

This is as opposed to “soft rendering,” or letting your computer just play your timeline without rendering. If you’ve got a lot of clips on your timeline that have had effects added to them, playing them without pre-rendering them can really burden your computer. Pre-rendering your timeline as you work allows the program to work more efficiently.

Pre-rendering falls into the category of good housekeeping, and we highly recommend you do it whenever you’ve added visual effects, your system starts to lug or your timeline doesn’t play back at full speed.

We discuss why and how to pre-render your timeline in much more detail in Chapter 6, Edit Video on the Timeline.

Where can I learn more about Sony Movie Studio 13?
There are not a lot of online resources for Movie Studio and DVD Architect Studio. However, those that exist are very good.

Most notably, Sony Creative Software (www.sonycreativesoftware.com/training) offers online tutorials as well as a helpful user-to-user forum.

Rob Strobbe also offers excellent help for DVD Architect and Vegas and Movie Studio users on his www.vegasvideohelp.com.

And, of course, my site, Muvipix.com offers both an extremely helpful forum and an ever-growing number of helpful tutorials for both basic and advanced functions of a number of popular video editing and DVD authoring programs. You’ll likely find me there, day or night, helping out where I can and answering questions.

Even if you’re not finding the program challenging, I hope you’ll drop by and say hello! We love to see our videomaker community grow!

Steve and the Muvipix team
We'll look at both of these interface modes and how to use each to put together your movie in Chapter 6, Edit Video on the Timeline.

The Project Media window

The Project Media window, in the upper left of the interface, lists all of the media (video, audio, stills, etc.) that you've imported into your Sony Movie Studio project.

Media can be added to your project in a number of ways, usually using the tools along the top of the window. You can:

- Capture video from a tape-based camcorder. When video is captured, it is streamed into the project in real time, the video recorded to your computer’s hard drive as it is added to the project’s media.
- Download video or stills from a hard drive or memory storage camcorder. When video is imported into your project using a tool like the Device Explorer, the video or other media files are simultaneously downloaded to your computer’s hard drive and added to your Movie Studio project.
- Rip video or audio from a disc. This method saves the media from the DVD or CD to your hard drive while adding it to your project.
- Import media from your hard drive. In many cases, the video, still photos or audio files are already on your computer. Importing adds these files to your Project Media list.

We'll look into all of the methods of adding media to your project and when and how to use each in Chapter 3, Get Media Into Your Project.

The Sony Movie Studio 13 interface

Unlike many consumer-based video editing programs available today, Sony Movie Studio looks and behaves like a full-blown professional editor. Its timeline looks and functions just like that of a professional editing system, its windows and toolbars offer access to a wealth of high-level features and its interface is crowded with easily-accessible tools.

In fact, once you've become familiar with what's here and how it all works, you'll likely find it relatively easy to transition to a professional editor like Adobe's Premiere Pro, Apple's Final Cut or, of course, Sony's Vegas Pro.

If you feel a need to, of course.

You may well find that this deep and affordable program is fully capable of doing everything you'll ever need!

Sony Movie Studio's default workspace is designed to keep all of your tools within easy reach. Even its high-level tools are only a click or two away. Yet, as we'll soon demonstrate, it's also a very easily customizable workspace. And, once you have created a custom layout for your interface, you can even save that configuration and recall it whenever you'd like. In fact, you can save up to nine different interface configurations!

New to version 13 is Simple Mode, a simplified interface with big, clear buttons for use in quickly assembling simple movie projects and for working on a touch-screen monitor.

The Platinum version of the program includes both Simple and Advanced modes.
Get to Know Sony Movie Studio 13

The Transitions window
As illustrated at the bottom of the previous page, the Transitions window (which also shares the tabbed space with the Explorer and Project Media windows) lists 25 categories of Sony transitions (as well as third-party plug-ins), each of which includes a number of individual transitions, bringing the total number of transitions included with the program to over 230.

Each of these transitions can be customized in a number of ways, so there’s really no limit to the number of possible transitions you can create for your movie!

We’ll tell you all about transitions and how to use them in Movie Studio project in Chapter 13, Add and Customize Transitions.

The Explorer window
Sharing a tabbed space with the Project Media window, the Explorer is a browse screen for locating media files on your computer’s hard drive.

As we’ll show you in Chapter 3, video, stills, graphics and audio can be added directly from the Explorer to your timeline. Doing this automatically adds these media clips to your Sony Movie Studio project and your Project Media list.

The Video FX window
Sony Movie Studio Platinum comes loaded with over 300 preset video effects in over 50 categories. Like transitions, these effects can be customized in a number of ways and can even be combined in a chain to create any number of possible special effects.

The effects in the Video FX window are presets based on the Sony Movie Studio plug-in effects set – a set you can easily add to, if you’d like. In fact, if you have the Platinum version of the program, you’ll find some additional effects from HitFilms among those listed.

We’ll define each of these effects and show you how to use and customize them in Chapter 12, Add and Adjust Video Effects.
Get to Know Sony Movie Studio 13

Media Generators
Media Generators are pre-composed clips that you can add to your timeline as is or customize as needed. Among these are solid color clips, checkerboards and color test patterns as well as a number of title templates.

We’ll show you how to use and modify clips from the Media Generator in Chapter 3, Get Media Into Your Project. And, in Chapter 11, Add and Customize Your Titles, we’ll show you how to use Media Generator title templates to create basic, scrolling or even animated titles.

The Trimmer
Hidden by default but launched by selecting the option from the View/Window menu (and commonly positioned between the Project Media window and the Preview window), the Trimmer is a workspace in which you can prepare or pre-trim your media clips prior to adding them to your timeline. The Trimmer includes its own playback window as well as its own mini-timeline and tool set.

We’ll show you all of the great things you can do in this workspace in Chapter 5, Prepare Your Media in the Trimmer Window.

The Preview window
The Preview window, illustrated to the right, displays the playback of the video you’ve assembled on your timeline. This window also includes a number of important tools, and we’ll show you how they all work in Chapter 10, Preview Window Tools.

The Timeline
The Timeline, illustrated below, is the main work area for assembling your movie. It’s where your media clips are arranged, where most of the effects are added and where your clips interact with each other.

In Movie Studio Platinum 13, you can have up to 20 video and 20 audio tracks on your timeline, and you can arrange them in any order you’d like.

Since this workspace plays such a major role in the video editing process, no single chapter could say everything there is to say about it. So, in Chapter 6, we’ll show you how to Edit Video on the Timeline and, in Chapter 7, we’ll show you More Timeline Tools. Then, in Chapter 9, we’ll show you how to Edit Audio on the Timeline.
Additional “Pop-up” windows

In addition to the windows that make up the basic interface, there are several windows that “pop up” as needed:

The Video FX dialog window

Whenever you add an effect to video clip, the Video FX dialog window will pop open. On this window, you can add or remove effects from your effects “chain,” customize the effect to your specific need or add keyframed animation.

You don’t need to close this window, by the way, once you’ve made adjustments to an effect. Any adjustments you make are added to your clip in “real time,” and the results immediately appear in the Preview window. In fact, if you’ve got room on your computer’s desktop, you can leave this window open and it will automatically update when you add a new effect or edit an effect added to another clip.

We discuss this window in detail in Chapter 12, Add and Adjust Video Effects.

The Audio FX dialog window

The Audio FX dialog window functions similarly to the Video FX window. We’ll show you how to add effects to your audio in Chapter 12, Add and Adjust Audio Effects.

The Plug-in Chooser

The Plug-in Chooser lists all of the video effects, audio effects and transitions that have been loaded into your program. In fact, the effects listed on the Video FX panel (page 9) are actually just presets of the program’s video effects plug-ins.

Whenever you select the option to add a video effect, audio effect or transition to a media clip, event, audio or video track or an entire project, the big Plug-in Chooser window will pop open. (There is one list of plug-ins for video effects, another for audio effects and another for transitions.)

Once you select the effect to apply, the Plug-in Chooser will close and you will have access to the Video FX or Audio FX dialog window (described on the facing page) in which you can customize the effect.

We’ll tell you more about these effects and how to use them in Chapter 12, Add and Adjust Video Effects and in Chapter 13, Add and Adjust Audio Effects.

By the way, you can easily add more effects to your plug-in set. We show you how on page 186.

The Pan/Crop Motion dialog window

To add some interest and movement to your slidehows, you may want to pan and zoom around your still photos la Ken Burns. The Pan/Crop Motion dialog window is Movie Studio’s very intuitive interface for creating animated motion paths around your video or stills.

We’ll show you how to use this great tool for creating pans, zooms and crops around your clips in Chapter 8, Work With Photos.
Customize your workspace

Although the default set-up for the interface makes fairly efficient use of your computer desktop space, you can easily customize it (temporarily or permanently) so that you can focus on a particular window or two.

Resize the windows

To resize the program’s windows, hover your mouse over the seams between them. When you see a double-headed arrow resizer indicator (illustrated above), click and drag. As you drag one window larger, the other windows will resize to allow for it.

Maximize/Minimize the windows

The arrow buttons at the top left of each window are single-click ways to temporarily maximize or minimize a window’s size.

Click on the arrow at the upper left of the Explorer window, for instance, it will snap to the full width of the program’s interface. Click again on the arrow and the window snaps back to its original size.

Dock or undock the windows

If you click and drag on the “...” at the top or left side of any window (officially called the “gripper”), you can pull that window completely free from the interface so that it becomes a “floating” window.

• Once you’ve dragged the window free from the interface, you can place it anywhere you’d like on your desktop. If you’re using a two monitor system on your computer, you can undock any or all of the program’s windows and spread them out over your desktop.

• If you hold down the Ctrl key and drag a window into any of the “drop zones” in the program (areas of the interfaces in which windows already reside), when you release your mouse button the window will drop right into this space – becoming a tabbed window set or a new window panel in the interface.

Save and load a Window Layout

A very nice bonus feature in Sony Movie Studio is its ability to save your various Window Layouts.

Occasionally, for instance, you may need to rearrange the windows in the program’s interface in order to allow more space for the Timeline. Or you may want to sometimes make the Preview window larger so that you can see the detail in the playback.

To save or recall a custom layout, just go to the View menu at the top of the interface and select the option to save or recall a layout in the sub-menu Window Layouts.

Movie Studio 13 allows you to save up to ten different interface configurations in addition to the program’s Default Layout.
Basic editing moves

No matter what you plan to do with your video and no matter how creatively you plan to do it, the video editing process itself will still follow the same basic structure.

Here’s a brief walk-through of the basic steps you’ll take for creating any video project in Sony Movie Studio 13.

### Start a project

You can start a new project by selecting the option on the Welcome Screen or by selecting the option under the Project menu at the top of the program.

A project should be set up to match, as closely as possible, the source footage you’re using to build your movie. Movie Studio 13 also includes the option to create “Match Media Settings” tool for automatically setting your project properties to match the specs of the video you’ll be working with.

In Chapter 2, Start a New Project, we’ll show you how to properly set up a new project and ensure that its settings provide you with the best performance and results possible.

### Gather your media

The assets, or media, you gather to create your movie can come from a variety of sources. These assets can include video, audio, music, photos and graphics.

As you gather, or import, your assets into your project, they will appear in the Project Media window.

There are three basic ways to get your media into your project, and which method you’ll use depends on where your media files are located.

- **Tape-based digital video is captured** into your project. MiniDV and HDV camcorders connect to your computer over a FireWire, or IEEE-1394 cable, connection. The camcorder’s playback is controlled by Movie Studio’s capture software, and the video segments you choose to capture are streamed onto your computer and into your project in real time.

- **Video, stills and other media are downloaded** from hard drive camcorders, cameras and other devices. Hard drive camcorders, including high-definition AVCHD units and those that record to flash memory cards, download their video to your computer as whole files rather than stream it in. Media files can also be downloaded from other sources, including DVDs, digital still cameras and phones. Movie Studio includes a Device Explorer tool (available under View/Window) for locating and downloading media from hard drive camcorders and other media storage devices.

- **Media that is already on your computer is imported** into your project. Video, stills, music and other media files that are already on your computer are imported into your project and added to your Project Media catalog.

We’ll show you how to use each of these methods to bring video, audio and stills photos into your project in Chapter 3, Get Media Into Your Project.
CHAPTER 1

Assemble your media clips on your timeline

Once you’ve imported your media clips into a project, they will appear listed in the Project Media window and you can begin the process of assembling your movie. This process is as simple, and as intuitive, as dragging the clips from the Project Media window to your timeline and then arranging them in the order you’d like them to appear.

Once you add your files to your timeline, you’ll have a number of options:

- **Trim your clips.** Trimming means removing footage from either the beginning or the end of a clip. To trim a clip, click to select the clip on your timeline and then drag in either the beginning or end (as discussed on page 78).
- **Split your clips.** Splitting means slicing through your clips so that you can remove footage from the middle or delete one sliced-off segment completely. To split a clip, position the Timeline Cursor (playhead) over your clip(s) at the point at which you’d like the slice to occur and click the Split button below the timeline (as discussed on page 79).
- **Place your clip on an upper video or audio track.** On a multi-track timeline, your clips don’t just follow one another – they also interact with each other. Your video tracks behave like layers of images. And how the clips are arranged on your upper tracks (or if they include transparent areas) determines how and how much of the clips on your lower tracks appear around or through them.

Add and adjust effects

Movie Studio comes loaded with dozens of video and audio effects. These effects can be added to a clip prior to adding it to the timeline, to an event or group of events on your timeline, to an entire video or audio track at once or to your project overall.

Once an effect has been added to your video or audio clip(s), a dialog window will open in which you can customize the effect or use keyframe to create an effect animation.

We’ll show you how to work with effects in Chapter 12, Add and Adjust Video Effects, and Chapter 13, Add and Adjust Audio Effects.

In addition to video and audio effects, Movie Studio includes tools for creating motion paths – pans and zooms (or crop) over your video or still photos. As with the other effects, you can use the Pan/Crop Motion tool to either create a pan and crop over an individual event on your timeline or use it to create this visual effect for an entire video track.

We’ll show you how to work the Pan/Crop Motion tool in Chapter 8, Work with Photos.
Add and adjust transitions

Transitions are visual effects that take us from one timeline event to another. Some are subtle and nearly invisible – others are showy and draw attention to themselves.

As with effects, once you add a transition to your timeline, a dialog window will open, allowing you to customize your transition in a number of ways.

You might be surprised to learn how many different ways there are to add and customize transitions – and we’ll show them to you in Chapter 14, Add and Customize Transitions.

Add titles

Titles are text placed over your clips to provide additional visual information for your video story.

There is more than one way to create a title. And, once you have created it, you can customize it in a number of ways. As with other video events on your timeline, you can add effects, like fade ins and fade outs, animation and even motion paths, to your titles.

We’ll show you how to do lots of great tricks with your titles in Chapter 11, Add and Customize Your Titles.

Output your movie

Once you’ve finished editing your Sony Movie Studio project, you’ll find lots of options for sharing it. From outputting your video for the web to exporting your movie to a portable device to sending your project to DVD Architect Studio for production as a DVD or BluRay disc, Movie Studio 13 offers a wealth of options for making your movie.

We’ll show you how to use these options and what the advantages of each output format are in Chapter 17, Make Your Movie.

And that’s basically it!

You gather your assets; you assemble them on your timeline; you add effects, transitions and titles; you share it with the world. But between the lines of this simplicity are the countless variations that can elevate your movie project from the realm of a basic home movie to something truly amazing!